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Introduction
Eﬁnix provides a soft RISC-V SoC, called Jade, that you can implement in Trion® FPGAs.
This user guide describes how to:
• Build RTL designs using the Jade RISC-V SoC using an example design targeting the
Trion® T20 BGA256 Development Board, and how to extend the example for your own
application.
• Set up the software development environment using an example project, create your own
software based on example projects, and use the API.
Figure 1: Designing Hardware and Software for the Jade RISC-V SoC
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1. Windows build tools required on Windows platforms only.
Learn more: Refer to the Jade RISC-V SoC Data Sheet for detailed specifications on the SoC.

VexRiscv RISC-V Core
The Jade SoC is based on the VexRiscv core created by Charles Papon. The VexRiscv core
is a 32-bit CPU using the ISA RISCV32I with M and C extensions, has ﬁve pipeline stages
(fetch, decode, execute, memory, and writeback), and a conﬁgurable feature set. In the Jade
SoC, the VexRiscv core supports an APB3 bus interface, has instruction and data caches, and
can run at speeds up to 1.2 DMIPS/MHz.
The VexRiscv core won ﬁrst place in the RISC-V SoftCPU contest in 2018.(1)

(1)

https://www.businesswire.com/news/home/20181206005747/en/RISC-V-SoftCPU-Contest-Winners-Demonstrate-CuttingEdge-RISC-V
www.efinixinc.com
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Required Software
To write software for the Jade SoC, you need the following tools. The SDK is available as a
single download in the Support Center for Windows and Ubuntu operating systems.

Efinity® Software
Eﬁnix development environment for creating RTL designs targeting Trion® FPGAs. The
software provides a complete RTL-to-bitstream ﬂow, simple, easy to use GUI interface, and
command-line scripting support.
Version: 2019.3

RISC-V SDK
Eclipse MCU—Open-source Java-based development environment that uses plug-ins to
extend and customize its functionality. The GNU MCU Eclipse plug-in lets you develop
applications for ARM and RISC-V cores.
Version: 2019.08.0
Disk space required: 320 MB (Windows), 375 MB (Linux)
xPack GNU RISC-V Embedded GCC—Open-source, prebuilt toolchain from the xPack
Project.
Version: 8.3.0-1.1
Disk space required: 1.46 GB (Windows), 1.4 GB (Linux)
OpenOCD Debugger—The open-suorce Open On-Chip Debugger (OpenOCD) software
includes conﬁguration ﬁles for many debug adapters, chips, and boards. Many versions of
OpenOCD are available. The Eﬁnix RISC-V ﬂow requires a custom version of OpenOCD
that includes the VexRiscv 32-bit RISC-V processor.
Version: 20200421
Disk space required: 9.4 MB (Windows), 7.4 MB (Linux)
GNU MCU Eclipse Windows Build Tool (Windows Only)—This open-source Windowsspeciﬁc package helps to manage build projects and includes GNU make.
Version: 2.12-20190422-1053
Disk space required: 3.8 MB

Java JRE
Open-source Java 64-bit runtime environment; required for Eclipse.
Version: 8 Update 241
https://www.java.com/en/download/manual.jsp

Required Hardware
•
•
•
•
•

Trion® T20 BGA256 Development Board
Micro-USB cable
Computer or laptop
(Optional) USB to UART converter module
(Optional) FTDI chip cable, C232HM-DDHSL-0, if you want to use the OpenOCD
debugger and Eﬁnity® Debugger simultaneously

www.efinixinc.com
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Note: Some of the software examples provided with the SoC use a UART terminal to display messages.
See Set Up a USB-to-UART Module on page 31 for more information.

Chapter 1

Install Software and SoC
Contents:
•
•
•
•

Install the Efinity Software
Install the RISC-V SDK
Install the Java JRE
Install the SoC Files

Install the Efinity® Software
If you have not already done so, download the Eﬁnity® software from the Support Center
and install it. For installation instructions, refer to the Eﬁnity Software Installation User
Guide.
Warning: Do not use spaces or non-English characters in the Efinity path.

Install the RISC-V SDK
To install the SDK:
1. Download the ﬁle riscv_sdk_windows-v<version>.zip or riscv_sdk_ubuntuv<version>.zip from the Support Center.

2. Create a directory for the SDK, such as c:\riscv-sdk (Windows) or home/my_name/
riscv-sdk (Linux).
3. Unzip the ﬁle into the directory you created. The complete SDK is distributed as
compressed ﬁles. You do not need to run an installer.
Windows directory structure:
• SDK_Windows
— eclipse—Eclipse application.
— GNU MCU Eclipse—Windows build tools.
— openocd—OpenOCD debugger.
— riscv-xpack-toolchain_8.3.0-1.1_windows—GCC compiler.
— run_eclipse.bat—Batch ﬁle that sets variables and launches Eclipse.
— setup.bat—Batch ﬁle to set variables for running OpenOCD on the command line to
ﬂash the binary.

Ubuntu directory structure:
• SDK_Ubuntu<version>
— eclipse—Eclipse application.
— openocd—OpenOCD debugger.
— riscv-xpack-toolchain_8.3.0-1.1_linux—GCC compiler.
— run_eclipse.sh—Shell ﬁle that sets variables and launches Eclipse.
— setup.sh—Shell ﬁle to set variables for running OpenOCD on the command line to
ﬂash the binary.

Install the Java JRE
To install the JRE:
1. Download the 64-bit version of the JRE for your operating system from www.java.com/
en/download/manual.jsp.
2. Follow the installation instructions on the Java web site to install the JRE.
Note: You need a 64-bit version of the Java JRE. If you use a 32-bit version, when you try to launch Eclipse
you will get an error that Java quit with exit code 13.

Install the SoC Files
To install the Jade SoC:
1. Download the ﬁle efx_jade_riscv_soc-v<version>.zip from the Support Center.
2. Create a directory called riscv at the root level of your ﬁle system.
3. Unzip the ﬁles into the riscv directory.

The ﬁles are organized in this directory structure:
• soc_Jade
— soc_Jade_hw—Hardware ﬁles.
- source—RTL source code.
- T20F256_devkit—Example Eﬁnity® project targeting the
Trion® T20 BGA256 Development Board.
- tb—Testbench ﬁles.
— soc_Jade_sw—Software ﬁles.
- bsp—Board speciﬁc package.
- software—Software examples.
- cpu0.yaml—CPU ﬁle for debugging.
- project_settings_jade.xml—Eclipse project settings ﬁle for Windows.
- project_settings_jade_linux.xml—Eclipse project settings ﬁle for Linux.

Chapter 2

Program the Board with the Jade RTL Design
Contents:
•
•

About the Example Design
Program the Development Board

Before working with software code, Eﬁnix recommends that you program your board
with an RTL design that instantiates the Jade SoC. The Jade SoC comes with an example
Eﬁnity® project and bitstream ﬁle to get you started quickly. This example targets the
Trion® T20 BGA256 Development Kit.

About the Example Design
This example targets the Trion® T20 BGA256 Development Kit. You can access the RTL
design ﬁles in the soc_Jade_hw/T20F256_devkit directory.
This example software blinks an LED and displays messages on a UART terminal.
Figure 2: Example Design Block Diagram
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Table 1: Example Design Implementation
FPGA

Logic Utilization
(LUTs)

Memory Blocks

fMAX (MHz)

Language

Efinity Version

T20 BGA256 C4

6,486

93

69.031

Verilog HDL

2019.3

Program the Development Board
The Jade SoC package includes an Eﬁnity hardware project for the T20 BGA256
development board. Download it to the board using these steps:
1. Open the project (soc_jadeSoc.xml) in the Eﬁnity software. The project is located in the
soc_Jade_hw/T20F256_devkit directory.
2. Review the design.

3. Connect the Trion® T20 BGA256 Development Board to your computer using a USB
cable.
4. Use the Eﬁnity® Programmer and SPI active programming mode. The bitstream ﬁle,
soc_jadeSoc.hex, is in the soc_Jade_hw/T20F256_devkit directory.
Note: Although you can use any programming mode, Efinix recommends using
SPI active, which programs the design into the flash device on the board. That way,
if you power cycle the board the FPGA configures with the SoC design.
Learn more: Instructions on how to use the Efinity® software and board documentation are available in
the Support Center.

Chapter 3

Launch Eclipse
The RISC-V toolchain includes the run_eclipse.bat ﬁle (Windows) or run_eclipse.sh ﬁle
(Linux) that adds the toolchain executables to your path and launches Eclipse. Always use
this executable to launch Eclipse; do not launch Eclipse directly.

Chapter 4

Set Up the Eclipse Workspace
When you ﬁrst start working with the Jade SoC, you need to conﬁgure your Eclipse
workspace and environment. Setting up a global development environment for your
workspace means you can store all of your Jade software code in the same place and you can
set global environment variables that apply to all software projects in your workspace.
You should use a unique workspace for your Jade SoC projects. Eﬁnix recommends using the
soc_Jade directory as the workspace directory.
Note: Efinix provides several RISC-V SoCs. Using the top-level SoC directory as your workspace means
that you can explore more than one SoC by simply switching workspaces.

1. Launch Eclipse.
2. If this is the ﬁrst time you are running Eclipse, create a new workspace. Otherwise,
choose File > Switch Workspace > Other to choose a new workspace directory and
click Launch.
3. Create your workspace environment variables; these variables apply to all projects in your
workspace. Choose Window > Preferences to open the Preferences window.

c
a

b

d

a) In the left navigation menu, expand C/C++ > Build.
b) Click C/C++ > Build > Environment.
c) Click Add and add the following environment variables:
Variable

Value

Description

BSP

efinix/EfxJadeSoc

Board-specific package for the SoC.

DEBUG

no

Enables or disables debug mode.
no: Debugging is turned off
yes: Debugging is enabled

DEBUG_OG no

Enables or disables optimization during
debugging.
Use an uppercase letter O not a zero.

d) Click Apply and Close.

Chapter 5

Create and Build a Software Project
Contents:
•
•
•
•

Create a New Project
Import Project Settings (Optional)
Enable Debugging
Build

After you set up your Eclipse workspace, you are ready to create a new project and build
it. These instructions walk you through the process using the EfxApb3Example example
project from the software directory.

Create a New Project
In this step you create a new project from the EfxApb3Example code example.
1. Launch Eclipse.
2. Select the Jade workspace if it is not open by default.
3. Make sure you are in the C/C++ perspective.
Import the EfxApb3Example example:
4.
5.
6.
7.
8.

Choose File > New > Makeﬁle Project with Existing Code.
Click Browse next to Existing Code Location.
Browse to the software\standalone\EfxApb3Example directory and click Select Folder.
Select <none> in the Toolchain for Indexer Settings box.
Click Finish.

Import Project Settings (Optional)
Eﬁnix provides a C/C++ project settings ﬁle that deﬁnes the include paths and symbols for
the C code. Importing these settings into your project lets you explore and jump through the
code easily.
Note: You are not required to import the project settings to build. These settings simply make it easier for
you to write and debug code.

To import the settings:
1.
2.
3.
4.
5.
6.

Choose File > Import to open the Import wizard.
Expand C/C++.
Choose C/C++ > C/C++ Project Settings.
Click Next.
Click Browse next to the Settings ﬁle box.
Browse to the project_settings_jade.xml (Windows) or
project_settings_jade_linux.xml (Linux) ﬁle in the SoC's software directory and click
Open.

Jade RISC-V SoC Hardware and Software User Guide

7. In the Select Project box, select the project name(s) for which you want to import the
settings.
8. Click Finish.

Eclipse creates a new folder in your project named Includes, which contains all of the ﬁles
the project uses.
After you import the settings, clean your project (Project > Clean) and then build (Project
> Build Project). The build process indexes all of the ﬁles so they are linked in your project.

Enable Debugging
When you set up your workspace, you deﬁned an environment variable for debugging with a
default value of no.
• To run the program for normal operation, keep DEBUG set to no.
• To debug with the OpenOCD debugger, set DEBUG to yes.
In debug mode, the program suspends operation after loading so that you can set breakpoints
or perform debug tasks.
To change the debug settings for your project, right-click the project name
EfxApb3Example in the Project Explorer and choose Properties from the pop-up menu.

www.efinixinc.com
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1.
2.
3.
4.
5.
6.
7.

Expand C/C++ Build.
Click C/C++ Build > Environment.
Click the Debug variable.
Click Edit.
Change the Value to yes.
Click OK.
Click Apply and Close.

Important: When you change the debug value for a project you previously built, you must clean the
project (Project > Clean) before building again. Otherwise, Eclipse gives a message in the Console that
there is Nothing to be done for 'all'

Build
Choose Project > Build Project or click the Build Project toolbar button.
The makefile builds the project and generates these ﬁles in the build directory:
• EfxApb3Example.asm—Assembly language ﬁle.
• EfxApb3Example.bin—Download this ﬁle to the ﬂash device on your board using
OpenOCD. When you turn the board on, the SoC loads the application into the RISC-V
processor and executes it.
• EfxApb3Example.elf—Use this ﬁle when debugging with the OpenOCD debugger.
• EfxApb3Example.hex—Hex ﬁle.
• EfxApb3Example.map—Contains the SoC address map.

www.efinixinc.com
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Chapter 6

Debug with the OpenOCD Debugger
Contents:
•
•
•

Create a Debug Configuration
Set Up Debug Environment
Debugging

With the Trion® T20 BGA256 Development Board programmed and the software built, you
are ready to conﬁgure the OpenOCD debugger and perform debugging. These instructions
use the EfxApb3Example example to explain the steps required.
Important: If you want to use the OpenOCD Debugger at the same time as the Efinity® Debugger, you
cannot use the same USB connection to the board because they conflict causing one of the applications to
crash. Refer to Efinity Debugger Crashes when using OpenOCD on page 40 for information on using
two USB cables to operate both debuggers simultaneously.

Create a Debug Configuration
1. Connect your board to your computer using a JTAG cable. If you are using an Eﬁnix
development board, you can use a USB cable instead.
2. Launch Eclipse by running the run_eclipse.bat ﬁle (Windows) or run_eclipse.sh
(Linux).
3. Select a workspace (if you have not set one as a default).
4. Open the EfxApb3Example project or select it under C/C++ Projects.
5. Right-click the EfxApb3Example project name and choose Debug As > Debug
Conﬁgurations.
6. Double-click GDB OpenOCD Debugging (or right-click and choose New
Conﬁguration). In the Main tab, EfxApb3Example displays under Project.
7. Enter build\EfxApb3Example.elf in the C/C++ Application box.
Figure 3: Debug Configuration Main Tab

www.efinixinc.com
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Set Up Debug Environment
Enter the paths to OpenOCD, GCC compiler, and SoC in the Debugger tab.
Figure 4: Debug Configuration Debugger Tab

1. Click the Debugger tab.
2. Copy and paste the following path into the OpenOCD Setup box:
Windows:
${RISCV_TOOLS_HOME}\openocd\build-win64\bin\openocd.exe

Linux:
${RISCV_TOOLS_HOME}/openocd/build-x86_64/bin/openocd

3. Under Conﬁg options, enter options for the FTDI driver and RISC-V CPU:
Windows:
-f ${workspace_loc}\soc_Jade_sw\bsp\efinix\EfxJadeSoc\openocd\ftdi.cfg
-c 'set CPU0_YAML insert\\workspace\\path\\soc_Jade_sw\\cpu0.yaml'
-f ${workspace_loc}\soc_Jade_sw\bsp\efinix\EfxJadeSoc\openocd\debug.cfg

www.efinixinc.com
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Note: For the cpu0.yaml path, make sure to use \\ as the directory separator because the first slash
escapes the second one. For example, c:\\riscv\\soc_Jade\\soc_Jade_sw\\cpu0.yaml.

Linux:
-f ${workspace_loc}/soc_Jade_sw/bsp/efinix/EfxJadeSoc/openocd/ftdi.cfg
-c 'set CPU0_YAML ${workspace_loc}/soc_Jade_sw/cpu0.yaml'
-f ${workspace_loc}/soc_Jade_sw/bsp/efinix/EfxJadeSoc/openocd/debug.cfg

4. Copy and paste the following path into the GDB Client Setup box:
Windows:
${RISCV_TOOLS_HOME}\riscv-xpack-toolchain_8.3.0-1.1_windows\bin\riscv-none-embed-gdb.exe

Linux:
${RISCV_TOOLS_HOME}/riscv-xpack-toolchain_8.3.0-1.1_linux/bin/riscv-none-embed-gdb

5. Add the following settings under Commands:
set arch riscv:rv32
set remotetimeout 250

6.
7.
8.
9.

Click the Startup tab.
Turn on Enable ARM semihosting under Initialization Commands.
Turn on Debug in RAM under Runtime Options.
Click Debug.
Note: If Eclipse prompts you to switch to the Debug Perspective, click Switch.

Debugging
After you click Debug in the Debug Conﬁguration window, the OpenOCD server starts,
connects to the target, starts the gdb client, downloads the application, and starts the
debugging session. Messages and a list of VexRiscv registers display in the Console. The
main.c ﬁle opens so you can debug each step.
1. Click the Resume button or press F8 to resume code operation. All of the LEDs on the
board blink continuously in unison.
2. Click Step Over (F6) to do a single step over one source instruction.
3. Click Step Into (F5) to do a single step into the next function called.
4. Click Step Return (F7) to do a single step out of the current function.
5. Double-click in the bar to the left of the source code to set a breakpoint. Double-click a
breakpoint to remove it.
6. Click the Registers tab to inspect the processor's registers.
7. Click the Memory tab to inspect the memory contents.
8. Click the Suspend button to stop the code operation.
9. When you ﬁnish debugging, click Terminate to disconnect the OpenOCD debugger.

www.efinixinc.com
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Figure 5: Perform Debugging

Learn more: For more information on debugging with Eclipse, refer to Running and debugging projects
in the Eclipse documentation.

www.efinixinc.com
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Chapter 7

Create Your Own RTL Design
Contents:
•
•
•
•
•

Target another FPGA
Update the FTDI Driver for another Efinix Board
Target Your Own Board
Create a Custom APB3 Peripheral
Remove Unused Peripherals from the RTL Design

After you have explored the Jade SoC using the included example Eﬁnity® project, you can
use these tips to modify the design for your own use.
Note: Efinix recommends that you use the provided example design project as a starting point instead of
creating a new project.

Target another FPGA
To change the design to target a diﬀerent FPGA:
1. Edit the project to change the FPGA, package, and speed grade.
2. Update the interface design.
a) Open the Interface Designer. The software prompts you that a device change was
detected. Click Update Design. The Interface Designer opens and shows invalid
assignments in the Message Viewer.
b) Open the Resource Assigner.
c) Click the instance name in the Message Viewer. The software jumps to that
assignment in the Resource Assigner. Pick a new resource and press enter.
d) Continue re-assigning pins until all assignments are valid.
e) Generate a constraint ﬁle and close the Interface Designer.
3. Compile your modiﬁed design.

Update the FTDI Driver for another Efinix
Board
The FTDI driver included with the Jade SoC speciﬁes the FTDI device VID and PID, and
board description for the Trion® T20 BGA256 Development Board. You can update the
driver to point to a diﬀerent Eﬁnix development board.
Note: All Efinix development boards have the same VID and PID; therefore, you only need to change the
board description.

To target a diﬀerent Eﬁnix development board, follow these steps with the development
board attached to the computer:
1. Open the Eﬁnity Programmer.

www.efinixinc.com
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2. Click the Refresh USB Targets button to display the board name in the USB Target
drop-down list.
3. Make note of the board name.
4. In a text editor, open the ﬁle soc_Jade_sw/bsp/efinix/EfxJadeSoC/openocd/
ftdi.cfg.
5. Change the ftdi_device_desc setting to match the board name. For example, use
this code to change the name from Trion T20 Development Board to Trion T20 MIPI
Development Board:
interface ftdi
ftdi_device_desc "Trion T20 MIPI Development Board"
#ftdi_device_desc "Trion T20 Development Board"
ftdi_vid_pid 0x0403 0x6010

6. Save the ﬁle.
7. Debug as usual in OpenOCD.

Target Your Own Board
The FTDI conﬁguration ﬁle included with the Jade SoC speciﬁes the FTDI device VID and
PID, and board description for the Trion® T20 BGA256 Development Board. The FTDI chip
on the board bridges between the USB connector on the board and the JTAG signals on the
T20 FPGA.
The Jade SoC also includes a conﬁguration ﬁle for the FTDI C232HM-DDHSL-0 JTAG
cable, which bridges between your computer's USB connector and the JTAG signals on the
FPGA.
Note: Refer to Connect the FTDI Cable on page 34 for instructions on using the cable.

Generally, when debugging your own board you use a JTAG cable to connect your
computer and the board. Therefore, you use the OpenOCD driver for that cable when
debugging. OpenOCD includes a number of conﬁguration ﬁles for standard hardware
products. These ﬁles are located in the following directory:
openocd/build-win64/share/openocd/scripts/interface (Windows)
openocd/build-x86_64/share/openocd/scripts/interface (Linux)
You can also write your own conﬁguration ﬁle if desired.
Follow these instructions when debugging with your own board:
1. Connect your JTAG cable to the board and to your computer.
2. Copy the OpenOCD conﬁguration ﬁle for your cable to the bsp/efinix/EfxJadeSoc/
openocd directory.
3. Follow the instructions for debugging, except target your conﬁguration ﬁle instead of the
ftdi.cfg ﬁle.
-f <path>/soc_Jade_sw/bsp/efinix/EfxJadeSoc/openocd/<my cable>.cfg

Create a Custom APB3 Peripheral
The Jade SoC package includes an example APB3 peripheral and software code that you can
use as a template to create your own peripheral. This example performs a memory checker
function: when the user binary begins operation, the memory checker writes to the memory

www.efinixinc.com

21

and then reads from it. It compares the read value to the expected value. If the values match,
LED 2 turns on.
• Refer to apb3_slave.v in the soc_Jade_hw/source directory for the RTL design.
• Refer to apb3_cl.h in the soc_Jade_sw/software/standalone/driver directory for the
C code.

Remove Unused Peripherals from the RTL
Design
The Jade SoC includes a variety of peripherals. if you do not want to use a peripheral, simply
remove the signal name from within the parentheses () in the JadeSoc JadeSoc_inst deﬁnition
in the top-level Verilog HDL ﬁle. For example, the SoC instantiation has these signals:
.system_i2c_0_io_sda_write
.system_i2c_0_io_sda_read
.system_i2c_0_io_scl_write
.system_i2c_0_io_scl_read

(system_i2c_0_io_sda_write),
(system_i2c_0_io_sda_read),
(system_i2c_0_io_scl_write),
(system_i2c_0_io_scl_read),

To disable I2C 0, remove the signal name in () as shown below:
.system_i2c_0_io_sda_write
.system_i2c_0_io_sda_read
.system_i2c_0_io_scl_write
.system_i2c_0_io_scl_read

(),
(),
(),
(),

Chapter 8

Create Your Own Software
Contents:
•
•
•
•

Deploying an Application Binary
About the Board Specific Package
Address Map
Example Software

Now that you have explored the methodology for designing with the Jade SoC, you can
develop your own software applications.

Deploying an Application Binary
During normal operation, the user binary application ﬁle (.bin) is stored in a SPI ﬂash device.
When the FPGA powers up, the Jade SoC copies your binary application ﬁle from the SPI
ﬂash device to the on-chip memory, and then begins execution.
For debugging, you can load the user binary (.elf) directly into the Jade SoC using the
OpenOCD Debugger. After loading, the binary executes immediately.
Note: The settings in the linker prevent user access to the on-chip RAM address. This setting allows the
embedded bootloader to work properly during a system reset after the user binary is executed but the
FPGA is not reconfigured.

Boot from a Flash Device
When the FPGA boots up, the Jade SoC copies your binary application ﬁle from a SPI ﬂash
device to the on-chip memory, and then begins execution.
The SPI ﬂash binary address starts at 0x0038_0000.
To boot from a SPI ﬂash device:
1. Power up your board. The FPGA loads the conﬁguration image from the on-board ﬂash
device.
2. When conﬁguration completes, the bootloader begins cloning a 32 KByte user binary ﬁle
from the ﬂash device at physical address 0x0038_0000 to the on-chip memory.
Note: It takes ~78 ms to clone a 32 KByte user binary (this is the default size).

3. The Jade SoC executes the user binary.

Boot from the OpenOCD Debugger
To boot from the OpenOCD debugger:
1. Power up your board. The FPGA loads the conﬁguration image from the on-board ﬂash
device.
2. Launch Eclipse and set up the debug environment for your project.
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3. When you click Debug, the debugger sends a soft reset to the SoC, and then writes the
user binary ﬁle to logical address 0xF900_0000, which is the starting address of the on-chip
memory.
4. The Jade SoC jumps to logical address 0xF900_0000 to execute the user binary.
5. The user binary is suspended on boot up. Click the Resume button to start the program.
Note: Refer to Debug with the OpenOCD Debugger on page 16 for complete instructions on
debugging.

Copy a User Binary to the Flash Device
To boot from a ﬂash device, you need to copy the binary to the device. These instructions
decribe how to use a command prompt or shell to ﬂash the user binary ﬁle. You use two
command prompts or shells:
• The ﬁrst terminal opens an OpenOCD connection to the SoC.
• The second connects to the ﬁrst terminal to write to the ﬂash.
Important: If you are using the OpenOCD debugger in Eclipse, terminate any debug processes before
attempting to flash the memory.

Set Up Terminal 1
1.
2.
3.
4.
5.

Open a Windows command prompt or Linux shell.
Change to SDK_Windows or SDK_Ubuntu.
Execute the setup.bat (Windows) or setup.sh (Linux) script.
Change to the soc_Jade_sw directory.
Type the following commands to set up the OpenOCD server:
Windows:
openocd.exe -f bsp\efinix\EfxJadeSoc\openocd\ftdi.cfg
-c "set CPU0_YAML cpu0.yaml"
-f bsp\efinix\EfxJadeSoc\openocd\flash.cfg

Linux:
openocd -f bsp/efinix/EfxJadeSoc/openocd/ftdi.cfg
-c "set CPU0_YAML cpu0.yaml"
-f bsp/efinix/EfxJadeSoc/openocd/flash.cfg

The OpenOCD server connects and begins listening on port 4444.

Set Up Terminal 2
1.
2.
3.
4.

Open a second command prompt or shell.
Enable telnet if it is not turned on. Turn on telnet (Windows)
Open a telnet local host on port 4444 with the command telnet localhost 4444.
Change to the build directory for your project. For example:
cd software/standalone/EfxApb3Example/build

5. In the OpenOCD shell or command prompt, use the following command to ﬂash the user
binary ﬁle:
flash write_image erase unlock <filename>.bin 0x380000

For example:
flash write_image erase unlock EfxApb3Example.bin 0x380000
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Close Terminals
When you ﬁnish:
• Type exit in terminal 2 to close the telnet session.
• Type Ctrl+C in terminal 1 to close the OpenOCD session.
Important: OpenOCD cannot be running in Eclipse when you are using it in a terminal. If you try to run
both at the same time, the application will crash or hang. Always close the terminals when you are done
flashing the binary.

Reset the FPGA
Press the reset button (SW1) on the Trion® T20 BGA256 Development Board.

About the Board Specific Package
The board speciﬁc package (BSP) deﬁnes the address map and aligns with the Jade
SoC hardware address map. The BSP ﬁles are located in the bsp/efinix/EfxJadeSoc
subdirectory.
Table 2: BSP Files
File or Directory

Description

app

Files used by the example software and bootloader.

include\soc.mk

Supported instruction set.

include\soc.h

Defines the system frequency and address map.

linker\default.ld

Linker script for the main memory address and size.

linker\bootloader.ld

Linker script for the bootloader address and size.

openocd

OpenOCD configuration files.

Note: If your binary is smaller than the default size (32 KB), change the LENGTH parameter in default.ld to
adjust for the different size and programming time.
MEMORY
{
ram (wxai!r) : ORIGIN = 0xF9000000, LENGTH = 32K
}

Address Map
Table 3: Default Address Map, Interrupt ID, and Cached Channels
Device

Address

Size

Interrupt ID

Region

Null

0x0000_0FFF - 0x0000_0000

4K

–

–

GPIO

0xF800_0FFF – 0xF800_0000

4K

[0]: 12

I/O

I2C 0

0xF801_8FFF – 0xF801_8000

4K

8

I/O

0xF801_9FFF – 0xF801_9000

4K

9

I/O

2

I C1

[1]: 13
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Device

Address

Size

Interrupt ID

Region

Machine timer

0xF800_8FFF – 0xF800_8000

4K

31

I/O

PLIC

0xF8C0_0FFF - 0xF8C0_0000

4K

–

I/O

SPI master 0

0xF801_4FFF – 0xF801_4000

4K

4

I/O

SPI master 1

0xF801_5FFF – 0xF801_5000

4K

5

I/O

UART

0xF801_0FFF – 0xF801_0000

4K

1

I/O

User peripheral

0xF880_0FFF – 0xF880_0000

4K

–

I/O

On-chip BRAM

0xF900_7FFF – 0xF900_0000

32K

–

Cache

–

–

25

I/O

External interrupt

Note: The RISC-V GCC compiler does not support user address spaces starting at 0x0000_0000.
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Example Software
To help you get started writing software for the Jade, Eﬁnix provides a variety of example
software code that performs functions such as communicating through the UART,
controlling GPIO interrupts, performing Dhrystone benchmarking, etc. Each example
includes a makefile and src directory that contains the source code.
Note: Many of these examples display messages on a UART. Refer to the following topics for information
on attaching a UART module and connecting to it in a terminal:
Learn how to attach a UART module.

Learn how to open an Eclipse terminal and connect to the UART module.

Table 4: Example Software Code
Directory

Description

blinkAndEcho

This example blinks an LED and prints a string on the UART
terminal.

bootloader

This software is the bootloader for the system.

common

Provides linking for the makefiles.

dhrystone

This example is a synthetic computing benchmark program.

driver

This directory contains the system drivers for the peripherals
(I2C, UART, SPI, etc.). Refer to API Reference on page 41 for
details.

EfxApb3Example

This example shows how to implement an ABP3 slave.

i2cDemo

This example shows how to connect to an MCP4725 digital-toanalog converter (DAC) using an I2C peripheral.

readFlash

This example shows how to read from a SPI flash device.

spiDemo

This code reads the device ID and JEDEC ID of a SPI flash
device and echoes the characters on a UART.

timerAndGpioInterruptDemo

This example shows how to use use interrupts with a timer and
GPIO.

userInterruptDemo

This example demonstrates user interrupts with UART
messages.

writeFlash

This example shows how to write to a SPI flash device.

blinkAndEcho Example
The blink and echo example (blinkAndEcho directory) is a simple example that shows how
to use a register pointer to output data for the GPIO and UART. The design blinks LEDs D3
through D8. When you type a character, it echoes it on a UART terminal.

dhrystone Example
The Dhrystone example (dhrystone directory) is a classic benchmark for testing CPU
performance. When you run this application, it performs dhrystone benchmark testing and
displays messages and results on a UART terminal.
The following code shows example results:
Dhrystone Benchmark, Version C, Version 2.2
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Program compiled without 'register' attribute
Using time(), HZ=12000000
Trying 500 runs through Dhrystone:
Final values of the variables used in the benchmark:
Int_Glob:
5
should be:
5
Bool_Glob:
1
should be:
1
....
Enum_Loc:
1
should be:
1
Str_1_Loc:
DHRYSTONE PROGRAM, 1'ST STRING
should be:
DHRYSTONE PROGRAM, 1'ST STRING
Str_2_Loc:
DHRYSTONE PROGRAM, 2'ND STRING
should be:
DHRYSTONE PROGRAM, 2'ND STRING
Microseconds for one run through Dhrystone: 40
Dhrystones per Second:
24472
User_Time : 245176
Number_Of_Runs : 500
HZ : 12000000
DMIPS per Mhz:
1.16

EfxApb3Example
This simple software design illustrates how to use an APB3 slave peripheral.
When you run the application, it blinks LEDs D3 - D8 and D10 alternately with D9 and
displays the message Jade_Soc: Example Design ! on the UART terminal. When
you stop the application the LEDs stop blinking and D9 turns on.

i2cDemo Example
The I2C interrupt example (i2cDemo directory) provides example code for an I2C master
writing data to and reading data from an oﬀ-chip MCP4725 device with interrupt. The
Microchip MCP4725 device is a single channel, 12-bit, voltage output digital-to-analog
converter (DAC) with an I2C interface.
The MCP4725 device is available on breakout boards from vendors such as Adafruit
and SparkFun. You can connect the breakout board's SDA and SCL pins to the
Trion® T20 BGA256 Development Board using:
• SCL—GPIOL_25, which is labeled as 25 on header H4
• SDA—GPIOL_29, which is labeled as 29 on header H4
The code assumes that the I2C block is the only master on the bus, and it sends frames in
blocks. When you run it, the application connects to the MCP4725 device and increases the
DAC value. It also prints the message Start on a UART terminal.
In this example:
• void trap() traps entries on exceptions and interrupt events
• void externalInterrupt() triggers an interrupt event

readFlash Example
The read ﬂash example (readFlash directory) shows how to read data from the SPI ﬂash
device on the Trion® T20 BGA256 Development Board. The software reads 124K of data
starting at address 0x380000, which is the default location of the user binary in the ﬂash
device. The application displays messages on a UART terminal:
Read
Addr
Addr
Addr
...
Addr
Addr

Flash Start
00380000 : =FF
00380001 : =FF
00380002 : =FF
0039EFFE : =FF
0039EFFF : =FF
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Read Flash End

spiDemo Example
The SPI example (spiDemo directory) provides example code for reading the device ID and
JEDEC ID of the SPI ﬂash device on the Trion® T20 BGA256 Development Board.
• The default base address map of the SPI ﬂash master is 0xF801_4000.
• The default SCK frequency is half of the SoC system clock frequency.
• The default base address of the UART is 0xF801_0000 with a default baud rate of 115200.
The application displays the results on a UART terminal. It continues to print to the
terminal until you suspend or stop the application.
Hello world
Device ID : 17
CMD 0x9F : EF4018
CMD 0x9F : EF4018
...

timerAndGpioInterruptDemo Example
The GPIO interrupt example (timerAndGpioInterruptDemo directory) provides example
code for implementing a rising edge interrupt trigger with a GPIO pin. When an interrupt
occurs, a UART terminal displays Hello world and then the timer interval. It continues to
print the timer interval until you suspend or stop the application.
Hello world
BSP_MACHINE_TIMER 0
BSP_MACHINE_TIMER 1
...

In this example:
• void trap() traps entries on exceptions and interrupt events
• void externalInterrupt() triggers a GPIO interrupt event

userInterruptDemo Example
The user interrupt example (userInterruptDemo directory) uses one bit from an APB3 slave
peripheral as an interrupt signal to RISC-V processor. The main routine sets up an interrupt
routine, then triggers an interrupt signal to the user interrupt port by programming bit 2 on
the ABP3 slave to high.
When the RISC-V processor receives the interrupt signal, program execution jumps from the
main routine to the interrupt (or priority) routine. The interrupt routine sets bit 2 low so the
processor can leave the interrupt routine.
The application displays the messages on a UART terminal:
User Interrupt Demo, waiting for user interrupt...
Entered User Interrupt Routine
Turn off Interrupt Signal
Leaving User Interrupt Routine

writeFlash Example
The read ﬂash example (writeFlash directory) shows how to write data to the SPI ﬂash
device on the Trion® T20 BGA256 Development Board. The software writes data starting
at address 0x380000, which is the default location of the user binary in the ﬂash device. The
application displays address and data messages on a UART terminal:
Write Flash Start
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WR Addr 00380000
WR Addr 00380001
WR Addr 00380002
...
WR Addr 003800FD
WR Addr 003800FE
WR Addr 003800FF
Write Flash End

: =00
: =01
: =02
: =FD
: =FE
: =FF

Chapter 9

Using a UART Module
Contents:
•
•

Set Up a USB-to-UART Module
Open a UART Terminal

Set Up a USB-to-UART Module
A number of the software examples display messages on a UART terminal. The
Trion® T20 BGA256 Development Board does not have a USB-to-UART converter,
therefore, you need to use a separate USB-to-UART converter module. A number of modules
are available from various vendors; any USB-to-UART module should work.
Figure 6: Connect the UART Module to I/O Header H4
Ground
TX
RX

UART
to USB
Module

USB
Connector

26 25 24 23 22 21 20 19 18 16 15 14 13 12 11
27 28 29 30 31 32 33 34 35 36 37 39 40 41 42 43
GND

GPIOL_26
GPIOL_28

H4

1. Connect the UART's RX, TX, and ground pins to the
Trion® T20 BGA256 Development Board using:
• RX—GPIOL_28, which is labeled as 28 on header H4
• TX—GPIOL_26, which is labeled as 26 on header H4
• Ground—Ground, connect to one of the GND pins on header H4
2. Plug the UART module into a USB port on your computer. The driver should install
automatically if needed.

Finding the COM Port (Windows)
1. Type Device Manager in the Windows search box.
2. Expand Ports (COM & LPT) to ﬁnd out which COM port Windows assigned to the
UART module; it is listed as USB Serial Port (COMn) where n is the assigned port
number. Note the COM number.

Finding the COM Port (Linux)
In a terminal, type the command:
dmesg | grep ttyUSB

The terminal displays a series of messages about the attached devices.
usb <number>: <adapter> now attached to ttyUSB<number>
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There are many USB-to-UART converter modules on the market. Some use an FTDI chip
which display a message similar to:
usb 3-3: FTDI USB Serial Device converter now attached to ttyUSB0

However, the Trion® T20 BGA256 Development Board also has an FTDI chip and gives the
same message. So if you have both the UART module and the board attached at the same
time, you may receive three messages similar to:
usb 3-3: FTDI USB Serial Device converter now attached to ttyUSB0
usb 3-2: FTDI USB Serial Device converter now attached to ttyUSB1
usb 3-2: FTDI USB Serial Device converter now attached to ttyUSB2

In this case the second 2 lines (marked by usb 3-2) are the development board and the ﬁrst
line (usb 3-3) is the UART module.
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Open a UART Terminal
You can use any terminal program, such as Putty, termite, or the built-in Eclipse terminal, to
connect to the UART module. These instructions explain how to use the Eclipse terminal;
the others are similar.
1. In Eclipse, choose Window > Show View > Terminal. The Terminal tab opens.

Open a Terminal
Disconnect Terminal Connection

2. Click the Open a Terminal button.
3. In the Launch Terminal dialog box, enter these settings:
Option

Setting

Choose terminal

Serial Terminal

Serial port

COMn (Windows) or ttyUSBn (Linux)

Baud rate

115200

Data size

8

Parity

None

Stop bits

1

Encoding

Default (ISO-8859-1)

where n is the port number for your UART module.

4. Click OK. The terminal opens a connection to the UART.
5. Run your application. Messages are printed in the terminal.
6. When you are ﬁnished using the application, click the Disconnect Terminal Connection
button.

www.efinixinc.com

33

Jade RISC-V SoC Hardware and Software User Guide

Chapter 10

Using a Soft JTAG Core instead of the JTAG
User Tap
Contents:
•
•

Update the Efinity Project for Soft JTAG Support
Connect the FTDI Cable

The Trion® T20 BGA256 Development Board has an FTDI chip to bridge between the USB
port and the JTAG interface on the T20 FPGA. The example design provided with the SoC
uses the JTAG User Tap interface block to do the JTAG connection. However, if you want
to use the Eﬁnity Debugger and OpenOCD debugger at the same time, you need to use a
soft JTAG block to handle the OpenOCD JTAG communication instead of the hard JTAG
interface. Then, you use the FTDI chip cable, C232HM-DDHSL-0, for JTAG signals.
Using the soft JTAG connection has two elements:
• Change your Eﬁnity® project to use the soft JTAG module.
• Connect the FTDI cable to the Trion® T20 BGA256 Development Board.

Update the Efinity® Project for Soft JTAG
Support
The Jade SoC includes the JadeSoc_softTap.v ﬁle in the soc_Jade_hw/source
directory. To use this ﬁle in your project:
1. Open the project ﬁle in the Eﬁnity® software.
2. Add the JadeSoc_softTap.v ﬁle from the source directory to the project.
3. Remove the JadeSoc.v from the project.

4. Change the module name in the top_jadeSoc.v ﬁle.

5. Copy the JadeSoc_softTap.v_*.bin from the source folder to your project folder.
6. In the Interface Designer:

a) Remove the JTAG TAP block.
b) Add GPIO for the JTAG pins.
7. If you want to use the Eﬁnity Debugger, add a Virtual I/O or Logic Analyzer debug core
to the design.
8. Recompile.

Connect the FTDI Cable
When you modiﬁed your project to use the soft JTAG block, you assigned GPIO for the 4
JTAG signals, TMS, TDK, TCI, TDO. These GPIO should be assigned to header pins on the
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Trion® T20 BGA256 Development Board so you can connect the C232HM-DDHSL-0 FTDI
chip cable to those pins.
Figure 7: Connecting the C232HM-DDHSL-0 Cable
USB
Connector

TCK TDI TDO TMS GND Connect to
Ground Pin
Connect to GPIO pins
you assigned in the
Interface Designer.
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Enable Telnet on Windows
Windows does not have telnet turned on by default. Follow these instructions to enable it:
1. Type telnet in the Windows search box.
2. Click Turn Windows features on or oﬀ (Control panel). The Windows Features dialog
box opens.
3. Scroll down to Telnet Client and click the checkbox.
4. Click OK. Windows enables telnet.
5. Click Close.

Chapter 12

Troubleshooting
Contents:
•
•
•
•
•
•
•
•

Error 0x80010135: Path too long (Windows)
OpenOCD Error: timed out while waiting for target halted
OpenOCD error code (-1073741515)
OpenOCD Error: no device found
OpenOCD Error: failed to reset FTDI device: LIBUSB_ERROR_IO
OpenOCD Error: target 'fpga_spinal.cpu0' init failed
Eclipse Fails to Launch with Exit Code 13
Efinity Debugger Crashes when using OpenOCD

Error 0x80010135: Path too long (Windows)
When you unzip the SDK on Windows, you may get the error message:
An unuexpected error is keeping you from copying the file. If you continue
to receive this error, you can use the error code to search for help with
this problem.
Error 0x80010135: Path too long

This error occurs if you try to unzip the SDK ﬁles into a deep folder hierarchy instead of one
that is close to the root level. Instead unzip to c:\riscv-sdk.

OpenOCD Error: timed out while waiting for
target halted
The OpenOCD debugger console may display this error when:
• There is a bad contact between the FPGA header pins and the programming cable.
• The FPGA is not conﬁgured with a Jade SoC design.
• You may not have the correct PLL settings to work with the Jade SoC.
• Your computer does not have enough memory to run the program.
To solve this problem:
• Make sure that all of the cables are securly connected to the board and your computer.
• Check the JTAG connection.
• Ensure that the FPGA is programmed with the Jade SoC. Refer to Program the
Development Board on page 9.

OpenOCD error code (-1073741515)
The OpenOCD debugger may fail with error code -1073741515 if your system does not
have the libusb0.dll installed. To ﬁx this problem, install the DLL. This issue only aﬀects
Windows systems.
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OpenOCD Error: no device found
The FTDI driver included with the Jade SoC speciﬁes the FTDI device VID and PID, and
board description. In some cases, an early revision of the Eﬁnix development board may have
a diﬀerent name than the one given in the driver ﬁle. If the board name does not match the
name in the driver, Open OCD will fail with an error similar to the following:
Error: no device found
Error: unable to open ftdi device with vid 0403, pid 6010, description 'Trion T20 Development
Board',
serial '*' at bus location '*'

To ﬁx this problem, follow these steps with the development board attached to the computer:
1. Open the Eﬁnity Programmer.
2. Click the Refresh USB Targets button to display the board name in the USB Target
drop-down list.
3. Make note of the board name.
4. In a text editor, open the ﬁle soc_Jade_sw/bsp/efinix/EFXJadeSoC/openocd/
ftdi.cfg.
5. Change the ftdi_device_desc setting to match your board name. For example,
use this code to change the name from Trion T20 Development Board to Trion T20
Developer Board:
interface ftdi
ftdi_device_desc "Trion T20 Developer Board"
#ftdi_device_desc "Trion T20 Development Board"
ftdi_vid_pid 0x0403 0x6010

6. Save the ﬁle.
7. Debug as usual in OpenOCD.

www.efinixinc.com

38

Jade RISC-V SoC Hardware and Software User Guide

OpenOCD Error: failed to reset FTDI device:
LIBUSB_ERROR_IO
This error is typically caused because you have the wrong Windows USB driver for the
development board. If you hav e the wrong driver, you will get an error similar to:
Error: failed to reset FTDI device: LIBUSB_ERROR_IO
Error: unable to open ftdi device with vid 0403, pid 6010, description
'Trion T20 Development Board', serial '*' at bus location '*'

Important: Efinix recommends using the libusbK driver, which you install using the Zadig software.

Install the USB Driver
The following instructions explain how to install a USB driver.
Linux: Use the command:
> sudo <installation directory>/bin/install_usb_driver.sh

Windows: Follow these instructions:
1. Download the Zadig software from zadig.akeo.ie. (You do not need to install it; simply
run the downloaded executable.)
2. Run the Zadig software.
Note: To ensure that the USB driver is persistent across user sessions, run the
Zadig software as administrator.

3. Choose Options > List All Devices.
4. Turn oﬀ Options > Ignore Hubs or Composite Parents.
5. Select the board or cable to target:
• Select the Eﬁnix development board; if there is more than one, choose the one shown
as a composite.
• Alternatively, if you are using the FTDI Chip C232HM-DDHSL-0 programming
cable, select FTDIBUS (<version>) and USB ID 0403 6014 for the C232HMDDHSL-0 cable.
6. Select one of the following options in the Driver drop-down list. (Do not choose
WinUSB.)
Option

libusb-win32 (version)

libusbK (version)

Description

This driver is more stable for unplug/plug
events. This driver does not work when
debugging with OpenOCD.
Use this driver if you plan to use OpenOCD
to debug any Efinix RISC-V SoC.

7. Click Replace Driver.
8. Repeat step 2 for each unique JTAG device you want to target. For example, if you want
to use both the T8 and T20 development boards, you must install 2 USB drivers, one for
each board.
9. Close the Zadig software.
When you open the Device Manager in the Windows Control Panel, it displays the new USB
device driver.
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Note: The FTDI (FT2232) chips on Efinix development boards communicate with the USB port. These
chips have separate channels for SPI and JTAG. Therefore, you must install the driver for the composite
parent, not for the individual SPI and JTAG interfaces. If you install the driver for each interface, each
interface appears as a unique FTDI device, which will make it hard to select the correct port during
programming. Hint: the interface names end with (Interface N), where N is the channel number; do not
choose these.

OpenOCD Error: target 'fpga_spinal.cpu0' init
failed
You may receive this error when trying to debug after creating your OpenOCD debug
conﬁguration. The Eclipse Console gives an error message similar to:
Error cpuConfigFile C:RiscVsoc_Jadesoc_jade_swcpu0.yaml not found
Error: target 'fpga_spinal.cpu0' init failed

This error occurs because the path to the cpu0.yaml ﬁle is incorrect, speciﬁcally the slashes
for the directory separators. You should use:
• a single forward slash (/)
• 2 backslashes (\\)
For example, either of the following are good:
C:\\RiscV\\soc_Jade\\soc_jade_sw\\cpu0.yaml
C:/RiscV/soc_Jade/soc_jade_sw/cpu0.yaml

Eclipse Fails to Launch with Exit Code 13
The Eclipse software requires a 64-bit version of the Java JRE. If you use a 32-bit version,
when you try to launch Eclipse you will get an error that Java quit with exit code 13.
If you are downloading the JRE using a web browser from www.java.com, it defaults to
getting the 32-bit version. Instead, go to https://www.java.com/en/download/manual.jsp
to download the 64-bit version.

Efinity® Debugger Crashes when using
OpenOCD
The Eﬁnity® Debugger crashes if you try to use it for debugging while also using OpenOCD.
Both applications use the same USB connection to the development board, and conﬂict if you
use them at the same time. To avoid this issue:
• Do not use the two debuggers at the same time.
• Use an FTDI cable and a soft JTAG core for OpenOCD debugging. See Using a Soft
JTAG Core instead of the JTAG User Tap on page 34 for details.

Chapter 13

API Reference
Contents:
•
•
•
•
•
•
•
•
•

Control and Status Registers
GPIO API Calls
I2C API Calls
I/O API Calls
Machine Timer API Calls
PLIC API Calls
SPI API Calls
SPI Flash Memory API Calls
UART API Calls

The following sections describe the API for the code in the driver directory.

Control and Status Registers
csr_clear()
Usage

csr_clear(csr, val)

Include

driver/riscv.h

Description

Clear a CSR.

csr_read()
Usage

csr_read(csr)

Include

driver/riscv.h

Description

Read from a CSR.

Example

csrr (t0, mepc) // Write mepc in regfile[t0]

csr_read_clear()
Usage

csr_read_clear(csr, val)

Include

driver/riscv.h

Description

CSR read and clear bit.

csr_read_set()
Usage

csr_read_set(csr, val)

Include

driver/riscv.h

Description

CSR read and set bit.
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csr_set()
Usage

csr_set(csr, val)

Include

driver/riscv.h

Description

CSR set bit.

csr_swap()
Usage

csr_write(csr, val)

Include

driver/riscv.h

Description

Swaps values in the CSR.

csr_write()
Usage

csr_write(csr, val)

Include

driver/riscv.h

Description

Write to a CSR.

Example

csrw (mepc, t0); // Write regfile[t0] in mepc

GPIO API Calls
gpio_getInput()
Usage

gpio_getInput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Get input from a GPIO.

[IN] value GPIO pin bitwise

gpio_getOutput()
Usage

gpio_getOutput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Read the output pin.

[IN] value GPIO pin bitwise

gpio_setOutput()
Usage

gpio_setOutput(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set GPIO as 1 or 0.

[IN] value GPIO pin bitwise

www.efinixinc.com

42

Jade RISC-V SoC Hardware and Software User Guide

gpio_setOutputEnable()
Usage

gpio_setOutputEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set GPIO as an output enable.

[IN] value GPIO pin bitwise

gpio_getOutputEnable()
Usage

gpio_getOutputEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Read GPIO output enable.

[IN] value GPIO pin bitwise

gpio_setInterruptRiseEnable()
Usage

gpio_etInterruptRiseEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt on the rising edge of the GPIO.

[IN] value GPIO pin bitwise

gpio_setInterruptFallEnable()
Usage

gpio_setInterruptFallEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt on the falling edge of the GPIO.

[IN] value GPIO pin bitwise

gpio_setInterruptHighEnable()
Usage

gpio_setInterruptHighEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt when the GPIO is high.

[IN] value GPIO pin bitwise

gpio_setInterruptLowEnable()
Usage

gpio_setInterruptLowEnable(GPIO_Reg, value)

Parameters

[IN] GPIO_Reg struct of GPIO register

Include

driver/gpio.h

Description

Set an interrupt when the GPIO is low.

[IN] value GPIO pin bitwise
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I2C API Calls
i2c_applyConfig()
Usage

void i2c_applyConfig(u32 reg, I2c_Config *config)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Apply I2C configuration to register or for initial configuration.

[IN] config struct of I2C configuration

i2c_clearInterruptFlag()
Usage

void i2c_clearInterruptFlag(u32 reg, u32 value)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Clear the I2C interrupt flag.

[IN] value I2C interrupt register

i2c_disableInterrupt()
Usage

void i2c_disableInterrupt(u32 reg, u32 value)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Disable I2C interrupt.

[IN] value I2C interrupt register

i2c_enableInterrupt()
Usage

void i2c_enableInterrupt(u32 reg, u32 value)

Parameters

[IN] reg struct of I2C setting value

Include

driver/i2c.h

Description

Enable I2C interrupt.

[IN] value I2C interrupt register

i2c_filterEnable()
Usage
Parameters

void i2c_filterEnable(u32 reg, u32 filterId, u32 config)
[IN] reg struct of I2C setting value

[IN] filterID filter configuration ID number
[IN] config struct of I2C configuration

Include

driver/i2c.h

Description

Enable the filter configuration.
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i2c_listenAck()
Usage

void i2c_listenAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Listen acknowledge from the slave.

i2c_masterBusy()
Usage

void i2c_masterBusy(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Get the I2C busy status.

i2c_masterDrop()
Usage

void i2c_masterDrop(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the drop state.

i2c_masterStart()
Usage

void i2c_masterStart(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the start status.

i2c_masterStartBlocking()
Usage

void i2c_masterStartBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Asserts a start condition.

i2c_masterStop()
Usage

void i2c_masterStop(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Change the I2C master to the stop status.
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i2c_masterStopBlocking()
Usage

void i2c_masterStartBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Asserts a stop condition.

i2c_masterStopWait()
Usage

void i2c_masterStopWait(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

The stop condition is wait busy..

i2c_setFilterConfig()
Usage
Parameters

void i2c_setFilterConfig(u32 reg, u32 filterId, u32 config)
[IN] reg struct of I2C setting value

[IN] filterID filter configuration ID number
[IN] config struct of I2C configuration

Include

driver/i2c.h

Description

Set the filter configuration.

i2c_txAck()
Usage

void i2c_txAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transmit acknowledge.

i2c_txAckBlocking()
Usage

void i2c_txAckBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Assert an ACK on the SDA pin.

i2c_txAckWait()
Usage

void i2c_txAckWait(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Wait for an acknowledge to transmit.

i2c_txByte()
Usage

void i2c_txByte(u32 reg, u8 byte)
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Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transfers one byte to the I2C slave.

[IN] byte 8 bits data to send out

i2c_txByteRepeat()
Usage

void i2c_txByteRepeat(u32 reg, u8 byte)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Send a byte and then wait until it is fully transmited on the I2C bus.

[IN] byte 8 bits data to send out

i2c_txNack()
Usage

void i2c_txNack(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Transfers a NACK.

i2c_txNackRepeat()
Usage

void i2c_txNackRepeat(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Send a NACK and then wait until it is fully transmited on the I2C bus.

i2c_txNackBlocking()
Usage

void i2c_ txNackBlocking(u32 reg)

Parameters

[IN] reg struct of I2C register

Include

driver/i2c.h

Description

Assert a NACK on the SDA pin.

i2c_rxAck()
Usage

int i2c_rxAck(u32 reg)

Parameters

[IN] reg struct of I2C register

Returns

[OUT] 1 bit acknowledge

Include

driver/i2c.h

Description

Receive an acknowledge from the I2C slave.

i2c_rxData()
Usage
Parameters

unit32_t i2c_rxData(u32 reg)
[IN] reg struct of I2C register
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Returns

[OUT] 1 byte data from I2C slave

Include

driver/i2c.h

Description

Receive one byte data from I2C slave.

i2c_rxNack()
Usage

int i2c_rxNack(u32 reg)

Parameters

[IN] reg struct of I2C register

Returns

[OUT] 1 bit no acknowledge

Include

driver/i2c.h

Description

Receive no acknowledge from the I2C slave.

I/O API Calls
read_u8()
Usage

u8 read_u8(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 8 bits.

read_u16()
Usage

u16 read_u16(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 16 bits.

read_u32()
Usage

u32 read_u32(u32 address)

Include

driver/io.h

Parameters

[IN] address SoC address

Description

Read address with unsigned 32 bits.

write_u8()
Usage

void write_u8(u8 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 8 bits unsigned data to the specified address.
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write_u16()
Usage

void write_u16(u16 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 16 bits unsigned data to the specified address.

write_u32()
Usage

void write_u32(u32 data, u32 address)

Include

driver/io.h

Parameters

[IN] data SoC address data
[IN] address SoC address

Description

Write 32 bits unsigned data to the specified address.

write_u32_ad()
Usage

void write_u32_ad(u32 address, u32 data)

Include

driver/io.h

Parameters

[IN] address SoC address
[IN] data SoC address data

Description

Write 32 bits unsigned data to the specified address.

Machine Timer API Calls
machineTimer_setCmp()
Usage

void machineTimer_setCmp(u32 p, u64 cmp)

Include

driver/machineTimer.h

Parameters

[IN] p machine timer interrupt

Description

Set a timer value to trigger an interrupt.

[IN] cmp machine timer compare register

machineTimer_getTime()
Usage

u64 machineTimer_getTime(u32 p)

Include

driver/io.h

Parameters

[IN] p machine timer interrupt

Returns

[OUT] timer value

Description

Gets the timer value.
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machineTimer_uDelay()
Usage

u64 machineTimer_uDelay(u32 usec, u32 hz, u32 reg)

Include

driver/io.h

Parameters

[IN] usec microseconds
[IN] hz core frequency

[IN] reg machine timer interrupt
Description

Use the machine timer to make a delay.

PLIC API Calls
plic_set_priority()
Usage

void plic_set_priority(u32 plic, u32 gateway, u32 priority)

Include

driver/io.h

Parameters

[IN] plic PLIC register structure
[IN] gateway interrupt type

[IN] priority interrupt priority
Description

Set the interrupt priority.

plic_set_enable()
Usage

void plic_set_enable(u32 plic, u32 target, u32 gateway, u32
enable)

Include

driver/io.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] gateway interrupt type
[IN] enable
Description

Set the interrupt enable.

plic_set_threshold()
Usage

void plic_set_threshold(u32 plic, u32 target, u32 threshold)

Include

driver/io.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] threshold enable = 1
Description

Masks individual interrupt sources for the HART.

plic_claim()
Usage

u32 plic_claim(u32 plic, u32 target)

Include

driver/io.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

www.efinixinc.com

50

Jade RISC-V SoC Hardware and Software User Guide

Description

Claim the PLIC interrupt

plic_release()
Usage

void plic_release(u32 plic, u32 target, u32 gateway)

Include

driver/io.h

Parameters

[IN] plic PLIC register structure
[IN] target HART number

[IN] gateway interrupt type
Description

Release the PLIC interrupt.

SPI API Calls
spi_applyConfig()
Usage

void spi_applyConfig(Spi_Reg *reg, Spi_Config *config)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Applies the SPI configuration to to a register for initial configuration.

[IN] config struct of the SPI configuration

spi_cmdAvailability()
Usage

spi_cmdAvailability(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Read the SPI command buffer.

spi_diselect()
Usage

void spi_select(Spi_Reg *reg, uint32_t slaveId)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

De-asserts the SPI select (SS) pin.

[IN] slaveId ID for the slave

spi_read()
Usage

uint8_t spi_write(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Returns

[OUT] reg One byte of data

Description

Receives one byte from the SPI slave.
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spi_rspOccupancy()
Usage

spi_rspOccupancy(Spi_Reg *reg)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Read the occupancy buffer.

spi_select()
Usage

void spi_select(Spi_Reg *reg, uint32_t slaveId)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Asserts the SPI select (SS) pin.

[IN] slaveId ID for the slave

spi_write()
Usage

void spi_write(Spi_Reg *reg, uint8_t data)

Include

driver/spi.h

Parameters

[IN] reg struct of the SPI register

Description

Transfers one byte to the SPI slave.

[IN] data 8 bits of data to send out

SPI Flash Memory API Calls
spiFlash_f2m_()
Usage

void spiFlash_f2m_(Spi_Reg * spi, u32 flashAddress, u32
memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] flashAddress flash device address
[IN] memoryAddress memory address
[IN] size programming address size

Description

Copy data from the flash device to memory.

spiFlash_f2m()
Usage

void spiFlash_f2m(Spi_Reg * spi, u32 cs, u32 flashAddress, u32
memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register
[IN] cs chip select

[IN] flashAddress flash device address
[IN] memoryAddress memory address
Description

Copy data from the flash device to memory with chip select control.
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spiFlash_f2m_withGpioCs()
Usage

void spiFlash_f2m_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio, u32
cs, u32 flashAddress, u32 memoryAddress, u32 size)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

[IN] flashAddress flash device address
[IN] memoryAddress memory address
[IN] size programming address size
Description

Flash device from the SPI master with GPIO chip select.

spiFlash_diselect()
Usage

void spiFlash_diselect(Spi_Reg *spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

De-asserts the SPI flash device from the master chip select.

[IN] cs chip select

spiFlash_diselect_withGpioCs()
Usage

void spiFlash_diselect_withGpioCs(Gpio_Reg *gpio, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] gpio reg struct of the GPIO register

Description

De-asserts the SPI flash device from the master with the GPIO chip select.

[IN] cs chip select

spiFlash_init_()
Usage

void spiFlash_init_(Spi_Reg * spi)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Initialize the SPI reg struct.

spiFlash_init()
Usage

void spiFlash_init(Spi_Reg * spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Initialize the SPI reg struct with chip select de-asserted.

[IN] cs chip select

spiFlash_init_withGpioCs()
Usage

void spiFlash_init_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio,
u32 cs)
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Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

Description

Initialize the SPI reg struct with GPIO chip select de-asserted.

spiFlash_select()
Usage

void spiFlash_select(Spi_Reg *spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Select the SPI flash device.

[IN] cs chip select

spiFlash_select_withGpioCs()
Usage

spiFlash_select_withGpioCs(Gpio_Reg *gpio, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] gpio reg struct of the GPIO register

Description

Select the SPI flash device with the GPIO chip select.

[IN] cs chip select

spiFlash_wake_()
Usage

void spiFlash_wake_(Spi_Reg * spi)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Release power down from the SPI master.

spiFlash_wake()
Usage

void spiFlash_wake(Spi_Reg * spi, u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

Description

Release power down from the SPI master with chip select.

[IN] cs chip select

spiFlash_wake_withGpioCs()
Usage

void spiFlash_wake_withGpioCs(Spi_Reg * spi, Gpio_Reg *gpio,
u32 cs)

Include

driver/spiFlash.h

Parameters

[IN] spi reg struct of the SPI register

[IN] gpio reg struct of the GPIO register
[IN] cs chip select

Description

Release power down from the SPI master with the GPIO chip select.
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UART API Calls
uart_applyConfig()
Usage

char uart_applyConfig(Uart_Reg *reg, Uart_Config *config)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Applies the UART configuration to to a register for initial configuration.

[IN] config struct of the UART configuration

uart_read()
Usage

char uart_read(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Returns

[OUT] reg character that is read

Description

Reads a character from the UART slave.

uart_readOccupancy()
Usage

uint32_t uart_readOccupancy(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Read the number of bytes in the RX FIFO.
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uart_write()
Usage

void uart_write(Uart_Reg *reg, char data)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Write a character to the UART.

[IN] data write a character

uart_writeStr()
Usage

void uart_writeStr(Uart_Reg *reg, char* str)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

Write a string to the UART TX.

[IN] str string to write

uart_writeAvailability()
Usage

uart_writeAvailability(Uart_Reg *reg)

Include

driver/uart.h

Parameters

[IN] reg struct of the UART register

Description

UART read/write FIFO.
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